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If you need terminal emulation, 
and you like EXTRA!... 

...you’re going to love Reflection 
2011! 

Upgrading from EXTRA!® to Reflection® 2011 
couldn’t be easier. When you start Reflection 
2011 the first time, you’ll find that all your 
existing macros, keyboard maps, and session 
files work as expected. Moreover, if you were 
using previous versions of Reflection, PComm, 
or RUMBA emulation software, you’ll find those 
sessions and macros work as well. With 
Reflection 2011, you’ll have the features you 
depend on for advanced productivity, secure 
multihost connectivity, and more. 

Reflection 2011 is more than just the latest 
version of the EXTRA! or Reflection products. 
Instead of an application designed for the 
operating systems that you were using a decade 
ago, Reflection 2011 gives you an emulator that 
has earned the right to use the Compatible with 
Windows 7 logo and is uniquely integrated with 
both Windows 7 and Microsoft Office 
applications. 

Windows 7 integration provides the first part of 
the range of security capabilities built into 
Reflection 2011, capabilities designed to help you 
meet evolving internal and external security 
requirements. 

Reflection 2011 integrates with Windows 7 User 
Account Control (UAC) to maximize your 
control over user access to administrative 
features and functions, and to minimize desktop 
vulnerabilities. 

Reflection 2011 protects the security of your 
data before, during, and after transmission by 
providing the security components from time-
tested cryptographic modules that meet the 
rigorous federal government FIPS 140-2 
standards. These security features provide 
secure access to hosts and gateways, provide the 
tools to verify the authenticity of hosts, 
gateways, and clients, and help you facilitate 
compliance with regulations such as Payment 
Card Industry (PCI) audits, Sarbanes-Oxley, 
HIPAA, FISMA, Basel II, and the EU Directive 
on data protection. 

Other terminal emulators may provide security 
through third-party partnerships, and even 
then, they typically support a lower level of 
certification. With Reflection 2011, you get a 
single-vendor solution integrated with the 
emulator and supported by the Attachmate 

dedicated security development, test, and 
technical support teams. 

Reflection 2011 is seamlessly integrated with 
Microsoft Office applications to provide a 
consistent user experience. And the productivity 
features that you used in EXTRA! are more 
powerful than ever. If you’ve been using 
PComm, RUMBA, or HostExplorer software, a 
previous version of Reflection, or any other 
emulator, you will be amazed at how much these 
tools increase productivity and save time. 

Using Reflection 2011, you can: 

· Open an e-mail message or Word document, 
and automatically include the current host 
screen content in the message or document. 

· Send a single screen or a series of screens to 
a PowerPoint presentation, and then create 
a training manual for your complex host 
application. 

· Configure privacy filters to prevent sensitive 
data, such as account and personal 
identification numbers, from being displayed 
in presentations or e-mail messages. 

· When connecting to IBM hosts, use the 
auto-complete and auto-expand functions to 
save time and keystrokes, and the built-in 
spell check function to reduce errors. 

Instead of just emulating a dumb terminal, 
Reflection 2011 makes your emulation sessions 
powerful, productive, secure, and easy to use. 

Open any number of sessions in the Reflection 
2011 workspace, connecting to any combination 
of mainframe, AS/400, UNIX, or OpenVMS 
hosts. Each session appears within its own 
tabbed window, making it fast and easy to move 
between sessions. Session documents include 
pointers to mouse maps, keyboard maps, theme 
files, hotspot files, and Ribbons that you can use 
to customize the behavior of each session. 

You can even open Web applications in the 
workspace, so that you can, for example, copy an 
address out of your customer database, paste it 
into your favorite online mapping application, 
and get directions to the customer location. Or, 
you can create a custom application using the 
Reflection .NET API model to do all that 
automatically. Once all of your sessions are 
configured to your liking, you can save them as 
a layout file that opens all of them together with 
a single click. 

If you’re not ready to migrate to Windows 7, 
you don’t have to wait to start taking advantage 
of the advanced capabilities of Reflection 2011. 
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Reflection 2011 supports your existing IT 
infrastructure, including the Windows 7, Vista, 
XP, Windows Remote Desktop Services, and 
Citrix XenApp platforms, as well as other 
virtualization platforms. 

If you don’t yet have the software, go to 
http://www.attachmate.com/Evals/Evaluate.htm 
and fill out the evaluation request form. You’ll 
be sent an e-mail message with instructions to 
download and install Reflection 2011. 

Once you’ve installed the software, you’ll want 
to take a brief tour of the new user interface. 

To open Reflection 2011 from the Start menu, 
select Attachmate Reflection, then select 
Reflection Workspace. The first time you open 
the workspace, you may have to wait briefly for 
the .NET framework to load.  

When the workspace is open, you’ll see the 
Create New Document dialog box. Close this for 
now, so that you can start getting acquainted 
with the Reflection 2011 user interface. 

Connecting to a Session 
To create a terminal session, complete the 
following steps: 

1. From the Quick Access toolbar, click the 
New Document button . 

 
The Quick Access toolbar is at the top of the workspace 

2. From the Create New Document dialog box, 
select the type of session you want to set up, 
and then click Create. 

 
The Create New 5250 Terminal Document dialog box 

3. Fill in the Host Name/IP Address field, and 
then click OK. The session opens in the 
workspace. 

To save the session document for the session 
you just created, click the Reflection 2011 File 
menu, choose Save As, name the session, and 
then click OK. Session information is stored in a 
session document. 

Using the Quick Access toolbar  
The Quick Access toolbar provides one-click 
access to common tasks. Move your mouse 
pointer over each button to reveal a ToolTip 
describing what it does. You can customize this 
toolbar to provide quick access to your most 
frequently performed tasks. 

To add a command to the toolbar, click   or   
 and select an action in the Action list. 

Alternate Interfaces 
With Reflection 2011, you can choose from three 
types of interfaces: Ribbon, Browser, or Classic. 

The Ribbon interface shares the look-and-feel of 
Microsoft Windows 7 and Office products. You 
access Reflection’s features and settings through 
the Ribbon’s expansive graphical interface. By 
default, Reflection opens in the Ribbon.  

 
The Ribbon interface 

The Browser interface has a look and feel that is 
similar to the latest Web browser interfaces 
where screen real estate is maximized. In the 
Browser, you access features and settings from 
the Reflection menu. 

 
The Browser interface 

Note: The Ribbon interface varies slightly for different Office products. 

The Classic interface is similar to legacy 
Reflection applications. In Classic UI, only one 
document can be open in a workspace, and other 
features may not be available. 

To switch interfaces, do the following: 

1. On the Reflection 2011 File menu, choose 
Reflection Workspace Settings. 

2. Click Configure Workspace Settings. 

http://www.attachmate.com/Evals/Evaluate.htm�
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3. Under User Interface, in the UI Preferences 
list, select User Interface Mode. 

4. Close Reflection 2011, and then reopen it to 
see the change. 

If you try out Classic mode, you’ll want to 
switch back to Ribbon or Browser mode to 
continue the evaluation.  

Many users prefer to use Reflection 2011 in Full 
Screen mode. At the bottom of the workspace, 
in the right-hand corner of the status bar, 
there’s an image of a screen  that you can 
click to switch between Full Screen and Normal 
mode.  

When you switch to Full Screen mode in the 
Ribbon, the Ribbon is minimized. To restore the 
Ribbon, click a Ribbon tab. 

Layouts 
If you regularly work with several sessions at 

the same time, you can save them all, together 
with any Web pages, as a layout. 

To create a Layout:  

· On the Reflection 2011 File menu, choose 
Save Layout. 

If you have open sessions that you haven’t 
saved yet, you’ll be prompted to save them. 

When you open a layout, Reflection 
automatically opens all documents that were 
open when you saved the layout, restores your 
workspace to the same size and location it was 
when you saved it, and connects terminal 
sessions to the configured hosts. 

An Integrated Browser 
Reflection 2011 includes an integrated Web 
browser (different from the Browser interface 
mode), which allows you to open a Web page 
from a tab in the workspace.   

 
Sample layout with the Ribbon (left) and the alternate Browser interface (right) 
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To add a Web page to your workspace: 

1. From the Quick Access toolbar, click the 
New Document button . 

2. From the Create New Document dialog box, 
select Web, and then click Create. 

3. In the URL box, type the URL for your 
favorite online mapping application, such as 
MapQuest or Google Maps, and then click 
OK.  

The mapping application displays within its 
own tab in the workspace. 

You can open as many terminal sessions and 
Web pages as your computer’s resources will 
support. They’ll each open in their own tab in 
the workspace. If you prefer to view your 
sessions side by side, you can display your 
session documents in windows rather than tabs. 

Search 
A search feature that you can use to find a 
string on the current page is an ordinary 

feature of many modern applications. Reflection 
2011 provides search tools that go well beyond 
the ordinary, providing you with the means to 
do the extraordinary.  

You can search the screen history of all open 
session documents, do a Windows desktop 
search, or a Google Web search. 

You can also, of course, search the current 
document, whether it’s a host session, a settings 
page, a Web page, or even the online Help. 

 

 

 

 

 

 

 

 
 

 
Sessions displayed in tiled windows 

 

To select the scope 
of your search, just 
enter your search 
string in the Search 
box in the upper 
right-hand corner of 
the workspace, and 
then click the down 
arrow next to the 
magnifying-glass 
icon. 
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The Reflection Browser provides additional 
search capability. In the browser search box, you 
can search for and access Reflection commands. 
You can also connect to sessions. 

To access a command in the Browser: 

· Enter the first letter of the command in the 
search box. Then select the command from 
the search results. 

To connect to sessions in the Browser: 

· Enter the connection type and host name  

For example, you can open Telnet sessions 
for a 3270 terminal using the following 
format: 

tn3270://hostName 

Provide Windows 7 Integration 
If you’re looking to Windows 7 to deliver 
improved desktop management, desktop 
security, and user productivity, you may be 
wondering about the level of Windows 7 
readiness you’ll get with Reflection 2011. 

Reflection 2011 has not only earned the 
Compatible with Windows 7 logo, but has been 
optimized to take full advantage of the security 
and productivity enhancements provided in 
Windows 7. For example, the integration 
between the Reflection 2011 Permissions 
Manager and Windows 7’s User Account 
Control allows you to specify, at a granular level, 
which tasks users can perform within Reflection 
2011. 

Reflection 2011 has, under license from 
Microsoft, incorporated the Microsoft Office 
Fluent User Interface. As implemented in 
Reflection 2011 and unique within the terminal 
emulation realm, the Ribbon provides a 
powerful, efficient, and fully customizable 
interface that can be tailored to meet the 
demands of your business workflow. 

For example, imagine that your users need to 
copy information from one host application and 
paste it into an application on a different host. 
You can save them time and keystrokes by 
automating this task, and letting them run it 
from a button on the Ribbon. 

To try this out for yourself, you’ll need to open 
two host sessions, and then use the following 
procedures to record the macro and create the 
button. 

Record the Macro 
1. Make sure the host application from which 

you want to copy the data is displayed. 

2. On the Tools tab of the Ribbon, click the 
Record Macro button  to start recording. 
(If this button isn’t visible, expand the 
window.) 

3. Navigate to the screen containing the data 
you want to copy. 

4. Select the data, right-click, and then select 
Copy. 

5. Click the tab for the second session. 

6. Navigate to the screen to which you want to 
paste the data. 

7. Position the cursor, right-click, and then 
select Paste. 

8. Click the Record Macro button  again to 
stop recording. 

9. Name the macro, and then click OK. 

The macro can be run by clicking Run Macro on 
the Session tab of the Ribbon, and then selecting 
it from the macros listed. 

Since you’d expect your users to perform this 
task frequently, you’ll want to use the built-in 
UI Designer utility to add a button to the 
Ribbon for your new macro. 

Add a Button to the Ribbon 
1. In the workspace, click the tab for the 

session from which you will run the macro. 

2. On the Appearance tab of the Ribbon, click 
UI Designer. 

3. Select the Macro group in the image of the 
Ribbon. 

4. From the Insert Controls pane, click Button. 

A new button is added to the Macro group. 

5. From the Settings pane, click Select Action. 

6. In the Action list, select Run Reflection 
Workspace Macro. 

Under Action Parameters, click Select 
Macro, choose the VBA project and macro to 
associate with this button, and then click 
OK. 

8. From the Settings pane, select Change 
Settings for “Run Reflection Workspace 
Macro.” 

9. Change the label and add a ToolTip. 

10. When you’re done, click OK. 

The new button appears on the Session tab 
of the Ribbon. 
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Strengthen Host Security 
Dealing with sensitive customer data requires 
security support on multiple levels. 

The US federal government is one of 
Attachmate’s largest customers, and demands 
the highest level of security from their products 
— for example, FIPS 140-2 for strong data 
encryption; Department of Defense PKI for 
strong certificate-based, 2-factor authentication; 
and FDCC/USGCB to prove that Reflection 2011 
can support a locked-down desktop 
configuration. 

The high level of Reflection security can help 
you comply with nongovernmental mandates 
driven by PCI audits, Sarbanes-Oxley, HIPAA, 
and Basel II. 

Protecting Mission-Critical Host Data 

Reflection 2011 includes information privacy 
features designed to protect customer data and 
secure the desktop. 

I. Set Up Privacy Filters 

Reflection 2011 includes features designed to 
protect customer data and secure the desktop. 
Privacy filters allow you to mask sensitive host 
data, such as personal identification numbers, 
and prevent that data from being printed, saved, 
or copied. 

Let’s say that you want to protect your 
customers’ telephone numbers. With Reflection 
2011, it’s easy: 

1. On the Ribbon File menu, choose Reflection 
Workspace settings. (In Browser mode, 
choose Settings > Reflection Workspace 
Settings from the Reflection menu.)  

2. In Reflection Workspace Settings, click Set 
up Information Privacy. 

3. Under Privacy Filters, click Add, and then, 
in the Simple expression box, type # symbols 
to represent the digits of the data you want 
to protect. For example: 

 ###-###-#### 

Be sure to use the formats that your host 
systems use to display these numbers. If 
telephone numbers are entered both with 
and without dashes, you’ll need to set up 
another filter without dashes. For example: 

########## 
 
 
 
 

4. Under Privacy Filters Redaction Rules, 
specify how to redact the data: 

· To redact sensitive data so that it is not 
displayed in productivity features, such 
as Office Tools integration, select Redact 
data when used outside the terminal. 

· To redact data on screens, select Redact 
display data (IBM terminals only). 

5. Click OK to save your changes. 

6. Connect to a host application that displays 
telephone number data to verify the data is 
redacted. 

II. Protecting Credit Card Data 

To help your organization meet Payment Card 
Industry Data Security Standard (PCI DSS) 
requirements, Reflection can also automatically 
protect credit/debit card data that is entered or 
stored on host screens. Let’s say that you want 
to protect credit card data. 

1. On the Ribbon File menu, choose Reflection 
Workspace settings. (In Browser mode, 
choose Settings > Reflection Workspace 
Settings from the Reflection menu.)   

2. In Reflection Workspace Settings, click Set 
up Information Privacy. 

3. Under Primary Account Number (PAN) 
Detection Rules, choose Simple PAN 
detection. 

4. Under Primary Account Number (PAN) 
Redaction Rules, choose Enable Redaction, 
Redact display data (IBM terminals only), 
and Redact data while typing (IBM 
terminals only). 

5. Click OK to save your changes. 

6. Connect to a host application that contains 
an input field long enough to enter a credit 
card number. 

7. Remove a credit card from your wallet and 
type the number into the input field. Notice 
that when you enter the last digit, the credit 
card number, except the last 4 digits, is 
redacted. 

Secure File Transfers 
Traditional protocols, such as Telnet and FTP, 
are not inherently secure. They put your 
confidential host data at risk. 

Reflection 2011 helps you manage that risk as 
your needs evolve — with comprehensive 
support for existing security infrastructures, 
user-level security features, and encryption 
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technology that meets today’s stringent security 
mandates. This level of security is unmatched by 
competitive products. 

Improve User Productivity 
The productivity of your end users is critical to 
meeting your business goals. Unique 
productivity features in Reflection 2011, such as 
Auto Complete, Auto Expand, Spell Check, 
Scratch Pad, Recent Typing, and Screen History 
save users thousands of keystrokes throughout 
the day, shortening call times while improving 
customer satisfaction. 

Just as importantly, these features improve the 
quality of data being entered into the system. 
No other emulator contains all of these tools. 

Because Reflection 2011 is integrated with 
current and older versions of Office applications, 
users can copy data from the host screen into a 
Word document, e-mail message, or PowerPoint 
slide with the click of a button. 

E-mail a Host Screen 
Suppose a sales representative needs complete 
information on a customer account. Sending the 
data is as easy as 1-2-3. 

1. Navigate to the appropriate screen, and then 
click the Office Tools button  on the 
Session Ribbon (or choose View > Office 
Tools from the Browser Reflection menu.) 

The Office Tools pane opens. 

2. From the Office Tools pane, under Create 
New, click E-mail Message. 

Reflection 2011 opens a new e-mail message 
in Outlook, with the current screen content 
pasted into it. If an account or telephone 
number was included in the screen, look 
closely at the image in the e-mail. Because 
you set up privacy filters, this sensitive 
information is obscured in the screen image 
in the e-mail message. 

3. Fill in the To and Subject lines of the e-mail, 
and then click Send. 

Find Host Screens Fast 
With the Reflection 2011 Screen History 
function, you can review host screens and use 
them in Office applications without having to 
navigate back to them. 

Display the screen history for the session by 
clicking the Screen History button  on the 
Session tab of the Ribbon.  (If you’re using 
Browser mode, you can display screen history by 

choosing View> Screen History from the 
Reflection menu.)  

Navigate through four or five host screens, and 
notice the way they appear in the Screen 
History pane. 

 

Now imagine that you have just received a call 
from a courier who needs to verify directions to 
a customer location. You’ve already been to the 
customer data screen. Rather than navigating 
back to it from wherever you are, Screen 
History provides two quick ways to get to the 
screen, so that you can give the courier the 
information he needs. 

1. If you only have a few screens to review, 
scroll through the Screen History pane, and 
then click the customer data screen to 
display it in the main session window. 

-or- 

If you have multiple screens to review, or the 
data needed is too hard to see: 

a. Enter the customer’s name in the Search 
box above the Ribbon. 

b. On the Search button , click the 
down arrow to open the Search menu, 
and then select Screen History Search. 

The Search Results appear below the 
terminal window, so that you can move 
quickly to the screen that has the 
required data. 

2. To get the directions for the courier, select 
the customer’s address on the screen, copy 
it, and then click the tab for the online 
mapping application. 

The Screen History pane 
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3. Paste the address into the destination 
address field. 

You can respond to a call from a courier and 
provide delivery directions that easily! 

Reflection 2011 productivity features accelerate 
data entry and host navigation, improving user 
efficiency while reducing data-entry errors. 

Maximize IT Flexibility 
IT infrastructures are constantly evolving and 
growing more complex. To maximize your 
return on investment, desktop applications 
should support and leverage other cost-saving 
IT technologies. 

Reflection 2011 supports a mix of existing IT 
infrastructure components, including Windows 
XP, Microsoft Active Directory, and Microsoft 
Group Policy technologies, and a variety of 
application virtualization technologies. In fact, 
Reflection was the first emulator to obtain the 
Citrix Ready logo. 

For more information on using Reflection 2011 
with these products, review Technical Note 
2380 on the Attachmate Support site. 

Reflection 2011 will work within your existing 
security infrastructure for handling user 
authorization and authentication. Reflection 
2011 supports Kerberos and PKI certificates, 
and Reflection Administrator (available as an 
add-on) allows you to centrally manage 
Reflection 2011 user configurations and host 
access. It also allows your end-users to launch 
Reflection 2011 sessions from a web page. 

All of the current Attachmate terminal 
emulation solutions support IPv6 and 64-bit 
computing. And Attachmate is currently 
focused on providing broad support for 
application virtualization technologies. 

Attachmate has been developing IT solutions 
that support emerging technologies for nearly 
30 years. As your business continues to evolve, 
Attachmate is committed to building solutions  

that maximize your IT investments and allow 
your IT organization to be as flexible as possible. 

Simplify Migration and Support 
Migrating from one desktop application to 
another is never easy. Migrations can be time 
consuming and resource intensive. 

However, supporting multiple emulation 
products also puts an ongoing and unnecessary 
drain on valuable IT resources. The problem is 
determining how to standardize on a single 
solution, without losing the custom macros, 
keyboard maps, and settings files you’ve created 
over the years, and without disrupting your 
users’ workflow. The solution is Reflection 2011. 

Compatibility tools built into Reflection 2011 run 
competitive macros, keyboard maps, and 
settings files, minimizing the risk of workflow 
disruption. 

Reflection 2011 has deeper support for Windows 
7 than any competitive terminal emulation 
product. It also has broader security options, 
unique user productivity tools, and wide-ranging 
support for existing and emerging technologies. 

You can successfully standardize on this next-
generation terminal emulation solution using 
Attachmate-proven tools and services. 

By providing Reflection 2011 to your emulation 
users, you’ll allow them to take advantage of the 
powerful features, robust security, and Windows 
7 integration that they can’t get anywhere else. 
Bottom line: Reflection 2011 is ready for 
Windows 7 when you are. 

For More Information on 
Reflection® 2011 

For more information about Reflection 2011, review the product 
Help. For further assistance regarding evaluation software and 
product updates, visit our Technical Support site at 
http://www.attachmate.com/en-US/Support/. 
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